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ABOUT THIS MANUAL

The SCOPIA Connector for IBM Lotus Sametime User Guide provides
information for administrators and end users about SCOPIA Connector
configuration and conference creation in the IBM Lotus Sametime environment.

Note The SCOPIA Connector plug-in works with the following IBM product
versions:

m  Sametime 7.5
m  Sametime 7.5.1
m  Sametime 7.5.1 CF1
m  Sametime 8.0 and 8.0.1
m  Lotus Notes 8.0
This manual refers to options available in Sametime 8.0.
Configuration options may vary according to the product version you are using.

RELATED The SCOPIA Connector documentation set is available in PDF format and as
DOCUMENTATION online help.

You require Adobe Acrobat Reader version 5.0 or later to open the PDF files.
You can download Acrobat Reader free of charge from www.adobe.com.

About This Manual vii
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FEEDBACK

The team at RADVISION constantly endeavors to provide accurate and
informative documentation. If you have comments or suggestions regarding
improvements to future publications, we would value your feedback.

Please send your comments to doc_comments@radvision.com.
We thank you for your contribution.
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ABOUT SCOPIA
CONNECTOR

SETTING SCOPIA
CONNECTOR
CONNECTIVITY

CONFIGURING SCOPIA CONNECTOR
PREFERENCES

m  Setting SCOPIA Connector Connectivity on page 1
m  Configuring a Meeting Room on page 2

m  Displaying Meeting Interface Embedded in the Sametime Client or in a
Separate Window on page 4

After you or your system administrator install the SCOPIA Connector plug-in,
the SCOPIA Connector Preferences page appears in the Sametime user interface.
You use the Preferences page to configure SCOPIA Connector.

The settings that you define in the Preferences page enable SCOPIA Connector
to invite new participants into a meeting. The settings are not used for accepting
meeting invitations that you receive or for joining meetings created by other
users.

This section describes how to configure connectivity between Sametime and
SCOPIA Connector.

Procedure

1 Inthe Sametime Connect client user interface, choose File >
Preferences, and click the Video Meeting link in the left panel.

2 Type the SCOPIA Desktop address in the Server field.

Configuring SCOPIA Connector Preferences 1



Configuring a Meeting Room

CONFIGURING A
MEETING Room

Check Use a Secure Connection (https) if SCOPIA Desktop is
configured with HTTPS for secure conferencing.

Click Test Server to send a message to SCOPIA Desktop to verify that
the server is running and that your settings are correct.

(Optional) If IBM Lotus Sametime Connect is configured to work with
a proxy, click Proxy Settings to instruct SCOPIA Connector to use the
settings configured for the Sametime community, or to specify your
own proxy settings.

Either select Use the Sametime default community proxy settings
Select Use custom proxy settings and enter proxy host, port, secure

connection and authentication information, then click OK to return to the
Video Meeting screen.

Click OK to save your preferences.

Related Topics

Configuring a Meeting Room on page 2.

You can configure meeting information for SCOPIA Connector to use. You can
choose to always use the same virtual room number, or to have SCOPIA
Connector prompt you to enter the meeting ID which you want to use for your
iVIEW Suite meetings. If you use the latter option, the Meeting ID dialog box is
displayed when the SCOPIA Connector is launched.

Before You Begin

Acquire a service prefix from your system administrator.

2 SCOPIA Connector for IBM Lotus Sametime User Guide



Configuring a Meeting Room

& Procedure

1 Inthe Sametime Connect client user interface, choose File >
Preferences, and click the Video Meeting link in the left panel.

2 To configure SCOPIA Connector to always connect to your virtual
room:

a Click Use your virtual room number.

b Enter the meeting room you are using for this meeting in the Room
Number field.

The room number is the service prefix used for the meeting followed
by the meeting ID used by SCOPIA Connector.

¢ (Optional) If the room is PIN-protected, enter the PIN for the
meeting in the Meeting PIN field.

Alternatively, to cause SCOPIA Connector to ask for a meeting ID, click
Always prompt for a meeting ID.

3 If the SCOPIA Desktop is configured to work with iVIEW Suite,
perform the following:

a Click Configure Virtual Room.

The virtual room page of the iVIEW Suite Administrator web
interface is displayed.

b If the SCOPIA Desktop is configured to work with iVIEW Suite,
verify that the meeting room number you configured in step 2b
matches the virtual room number configured via iVIEW Suite.

¢ Click OK.

4  Select Embed the video meeting in Sametime client to display the
SCOPIA Connector interface inside the Sametime client

Select Launch the video meeting in separate window to allow the
SCOPIA Connector interface to open in a separate window.

5 Click OK to save your preferences.

Configuring SCOPIA Connector Preferences 3



Displaying Meeting Interface Embedded in the Sametime Client or in a Separate Window

DISPLAYING This section describes how you define whether to display the meeting interface
MEETING within the Sametime client or to allow the meeting interface to open in a separate
INTERFACE window. Using the separate window mode, you have access to additional

EMBEDDED IN THE functionality such as room system application sharing and chat.

SAMETIME CLIENT
OR IN A SEPARATE
WINDOW

& Procedure

1 Inthe Sametime Connect client user interface, choose File >
Preferences, and click the Video Meeting link in the left panel.

2 Choose Embed the video meeting in Sametime client to use the
embedded SCOPIA Connector within the Sametime client user interface

Choose Launch the video meeting in separate window to launch
SCOPIA Desktop in a separate window.

3 Click OK to save your preferences.

4  SCOPIA Connector for IBM Lotus Sametime User Guide



CREATING AND CONNECTING TO A
SCOPIA CONNECTOR MEETING

m  Creating a SCOPIA Connector Meeting on page 5
m  How to Join a Meeting on page 7
m  Adding Meeting Participants from a Chat Session on page 10

CREATING A This section describes how to establish a SCOPIA Connector meeting from the
SCOPIA Sametime web user interface.

CONNECTOR A SCOPIA Connector meeting is associated with a Sametime chat session. Once
MEETING a meeting is established, only the virtual room created for the meeting is used for

the duration of the chat session.

You can establish a new SCOPIA Connector session after all participants have
left the existing SCOPIA Connector session.

Creating and Connecting to a SCOPIA Connector Meeting 5



Creating a SCOPIA Connector Meeting
& Procedure

1 Choose one or more entries from your Sametime contacts list and click
the SCOPIA Connector icon (Figure 2-1).

Figure 2-1 SCOPIA Connector Icon

® IBM Lotus Sametime Connect |Z|rz|
File Edit Yiew Toaols Help
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Q | Type ta find name
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Right-click one or more entries from your Sametime contacts list and
choose Video Meeting from the list.
Choose one or more contacts from your list and select Invite to Video

Meeting from the Tools menu. Alternatively, use the Ctrl+O keyboard
shortcut.

Click the SCOPIA Connector icon from inside an existing chat session
(Figure 2-2).
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How to Join a Meeting

Figure 2-2 Invitation from a Chat Session

£ Andy Lewis/RVSN [started: 4:29:43 PM] =
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2 Inall cases
o The initiator of the meeting automatically joins the meeting.
o Each invitee receives an invitation to connect to the meeting.

o Users who do not have the SCOPIA Connector plug-in installed
receive a Sametime Instant Message with a URL for joining the
meeting via a web page.

O Userswith other Instant Messengers using the IBM Lotus Sametime
Gateway receive a Sametime Instant Message with a URL for
joining the meeting via a web page.

How TO JOIN A m Joining a Meeting as the Meeting Organizer on page 8
MEETING m Joining a Meeting as an Invitee on page 9

Creating and Connecting to a SCOPIA Connector Meeting 7



How to Join a Meeting

JOINING A MEETING
AS THE MEETING
ORGANIZER

&

Procedure

1 If you selected the Embed the video meeting in Sametime client option
in the Video Meeting screen, perform these steps:

a

Ensure that you have filled the Server and Room Number fields in
the Video Meeting preferences page.

Choose one or more entries from your Sametime contacts list and
click the SCOPIA Connector icon.

Right-click one or more entries from your Sametime contacts list
and choose Video Meeting from the list.
Choose one or more contacts from your list and select Invite to

Video Meeting from the Tools menu. Alternatively, use the Ctrl+L
keyboard shortcut.

Click the SCOPIA Connector icon from inside an existing chat
session (Figure 2-2 on page 7).

2 Ifyou selected the Launch the video meeting in separate window option
in the Video Meeting screen, perform these steps:

a

b

On the Join Meeting tab displayed in the bottom pane of the
Sametime Connect client user interface, enter your name and the
meeting ID.

Click Participate Now.

Related Topics

m  Setting SCOPIA Connector Connectivity on page 1
m  Adding Meeting Participants from a Chat Session on page 10

8 SCOPIA Connector for IBM Lotus Sametime User Guide



JOINING A MEETING
AS AN INVITEE

How to Join a Meeting

Before You Begin

After you have installed SCOPIA Connector plug-in, you receive an invitation
via an Instant Messaging session informing you of the room number and the
name of the meeting organizer.

Procedure

1  Click Connect at the bottom of this message.

Note If you disconnect from the SCOPIA Connector meeting but keep the
Instant Messaging session open, you can return to the meeting via the same
invitation message.

If any of these apply:

O Yyou are using Sametime but have not installed the SCOPIA
Connector plug-in,

O Yyou are not using the same Instant Messenger as the meeting
organizer,

you receive an invitation via an Instant Messaging session instructing

you to contact your Sametime administrator to install the plug-in.

Click the link in the invitation message to join the meeting via the
web-based SCOPIA Connector client without installing the plug-in.

Creating and Connecting to a SCOPIA Connector Meeting
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Adding Meeting Participants from a Chat Session

ADDING MEETING You add meeting participants from a chat session by using the Invite others
PARTICIPANTS option. You can use this option as many times as you like; each time new users
FROM A CHAT receive an invitation to a video conference.

SESSION

& Procedure

1 Unless you are already in a video call, click the SCOPIA Connector
icon from inside your existing chat session (Figure 2-2 on page 7).

2 Click the Invite others icon (Figure 2-3).

Figure 2-3 Invite Others Icon

£ Andy Lewis/RVSN [started: 4:29:43 PM] =13
Fil= Edit Wiew Tools Help
B2 & D &
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3 Select invitees from the Invite Others dialog box and click Send.

If the chat session uses the SCOPIA Connector plug-in, the invitee
receives a SCOPIA Connector invitation. If not, the invitee receives an
invitation via the chat application.

10 SCOPIA Connector for IBM Lotus Sametime User Guide



MODERATING A MEETING

m  Viewing CPU Usage and Network Information on page 12
m Inviting an Attendee on page 13

= Muting Your Microphone or Speakers on page 15

m  Muting a Participant on page 15

m  Muting All Participants on page 15

m  Blocking a Participant’s Video on page 16

m  Disconnecting Participants on page 16

m Leaving a Meeting on page 16

m  Locking Down a Meeting on page 17

m  Terminating a Meeting on page 17

m  Activating/Deactivating Video Channels on page 17

m  Changing the Video Layout on page 19

m  Granting Permission to Speak to a Muted Attendee on page 21
m  Viewing the SCOPIA Connector Help on page 22

m  Viewing Licensing and Version Information on page 22

Moderating a Meeting 11



Viewing CPU Usage and Network Information

VIEWING CPU These status icons display at the bottom of the moderator live conference view.
USAGE AND

NETWORK Figure 3-1 Moderator Live Conference View Status Icons
INFORMATION

A

| |
CPU Network
overload icon
indicator

& Procedure

1 Check whether the CPU overload indicator is displayed or not.
The CPU overload indicator shows that your CPU usage is too
high and that video quality will become poor or stop
completely.

Note If the CPU overload indicator is displayed, we recommend that you
exit other applications currently running on your computer to clear CPU
resources.

2 Click the Network icon to display the Local tab in the Current
call section of the SCOPIA Connector Conference Client
Control Panel. For more information, see About Endpoint
Bandwidth Information on page 30.

Note A tooltip on the network icon indicates the current send/receive rates,
and whether or not tunneling is enabled. The tooltip is automatically updated
approximately every 2 seconds.

12 SCOPIA Connector for IBM Lotus Sametime User Guide



Inviting an Attendee

INVITING AN You can invite an attendee by either entering the address or selecting an attendee
ATTENDEE from the address book configured by an administrator.

& Procedure

From the Actions menu list, select Invite.
2 Type the E.164 number, SIP address or IP address of the
endpoint that you wish to invite.
Click Invite.
From the Actions drop-down menu, select Invite.

The Invitation Status dialog box (Figure 3-2) displays the most
recent invitations that you have sent together with an indication
of whether or not each invitation was successful.

5 (Optional) Click Show DTMF Keypad to display the dial pad.
You can use the dial pad to send DTMF tones. For example,
when you are required to type an extension number or choose
an option from a list when connected to an Interactive Voice
Response mechanism.

Figure 3-2 Invitation Dialog Box
/3 SCOPIA Desktop X
Please enter the destination address to call.
This can be a phone number, IP address, E.164 address, or SIF address.
Address: Select Contacts | Close |

6 To invite an attendee from the address book, perform these
steps:
a  Click Select Contacts.
The Select Contacts dialog box opens.

Moderating a Meeting 13



Inviting an Attendee

Figure 3-3 Select Contacts Dialog Box

2 Select Contacts X
Display Name Address

&) CA Main Conf 6599 i

@ Comora Islands Conf Room 5699

& France Conf Room 5399

& Hong Kong Conf 5499

& Japan Conf Room 5799

& korea Conf Room 5899

&) MH Main Conf room 192,168.115.250 B

@ MH Secondary ConfRoom 6298

& M1 Main Conf Room £399

&2 M15mall conf Ronm fi=9A hd

Search: - 2% Page1ofz M [« (M
oK Cancel

b  Double-click a contact from the list.
¢ Click OK.
7 Click Close to continue your meeting.
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Muting Your Microphone or Speakers

MUTING YOUR Muting reduces distractions and incidental noise in meetings. Unless you expect
MICROPHONE OR to speak frequently in a meeting, we recommend that you mute your
SPEAKERS microphone.

& Procedure

1 On the toolbar, click the Mute/Unmute Microphone icon to
mute or unmute your microphone.

2 Onthe toolbar, click the Mute/Unmute Speakers icon to mute
or unmute your speakers.

Figure 3-4 Microphone and Speakers Sliders

o2 LT [ LI

MUTING A
PARTICIPANT
& Procedure
1 From the Actions menu, select Mute.
2 Select the name of the participant that you want to mute or
unmute.
MUTING ALL
PARTICIPANTS
& Procedure

1 From the Actions menu, select Mute, and then select the Mute
All option.

The Mute All option disables the microphone for all
participants except the moderator.

Moderating a Meeting 15



Blocking a Participant’s Video

BLOCKING A
PARTICIPANT'S
VIDEO

DISCONNECTING
PARTICIPANTS

LEAVING A
MEETING

Moderators can block and unblock participants’ videos when necessary.

Procedure

1 To block a participant’s video:
a From the Actions menu, select Block Video.
b Select a participant.

The video of this participant is not transmitted. The option in the
Actions menu is marked as selected.

2 To unblock a participant’s video:
a From the Actions menu, select Block Video.
b Select a participant whose video is blocked.

The video of this participant is transmitted. The option in the
Actions menu is marked as not selected.

Moderators can use the Disconnect option to disconnect individual participants
from a meeting.

Procedure

1 From the Actions menu, select Disconnect.
2 Select the required participant.

Disconnected participants are returned to the SCOPIA
Connector login screen, but they are not disconnected from the
parent web-based application session.

Moderators and attendees can leave a meeting by using the Disconnect option at
the bottom of the Actions menu.

Procedure

1 From the Actions menu, select Disconnect.
The SCOPIA Connector login screen displays.

16 SCOPIA Connector for IBM Lotus Sametime User Guide



Locking Down a Meeting

Disconnecting from the SCOPIA Connector portion of a
meeting does not automatically disconnect you from the
Sametime chat session. To leave the Sametime chat session, you
must disconnect manually.

2 Click Add Video to rejoin the video meeting.

LOCKING DOWN A Moderators can use the Lock Down Meeting option to close a meeting to any
MEETING new or unwanted participants.
& Procedure

1 From the Actions menu, select Lock Down Meeting.
Your meeting is immediately closed to new participants.

TERMINATING A

MEETING
& Procedure
1 From the Actions menu, select Terminate Meeting.
The meeting is terminated.
ACTIVATING/ Moderators and attendees can use the Send Video option to block or unblock the
DEACTIVATING video channel from their terminal.

VIDEO CHANNELS
& Procedure

1  Click the camera icon to turn your camera on and off from
inside the video display.

In a double video display, the camera icon is located in the
frame displaying the local video.

Moderating a Meeting 17



Activating/Deactivating Video Channels

2 Alternatively, if you are using a double video display, you can
right-click in your local video frame and select Local Video >
Start or Stop.

18 SCOPIA Connector for IBM Lotus Sametime User Guide



Changing the Video Layout

CHANGING THE
VIDEO LAYOUT

& Procedure

1 From the Actions menu, select Change Layout > 1 video to
set a single video display, as shown in Figure 3-5.

Figure 3-5 Single Video Display with Picture-in-Picture

% David Dworkin [started: 1:15:57 PM] =13
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BEETRYYPDAAEGE D
& David Dworkin
1 am available (Sametime 7.5.1)

BzlaTaglb i v|go=lonm

Unpin toolbars | ..
Picture-in-Picture [Mi he - 2 NMW1.$ I_U_] @
Camera on/off o [l m- 2 @ ]
Remote video — 1?' _
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]

2 From the Actions menu, select Change Layout > 2 videos to
set a double video display, as shown in Figure 3-6.
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Changing the Video Layout

Figure 3-6 Double Video Display

¥ David Dworkin [started: 1:15:57 PM]
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3 Perform these actions as required:

o Click the Unpin toolbars icon to float the toolbar and
increase the size of the video frame.

o Click the Cameraicon to turn your camera on and off.
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GRANTING
PERMISSION TO

SPEAK TO A MUTED

ATTENDEE

&

Granting Permission to Speak to a Muted Attendee

o Click the Remote video icon, and then select one of
the following options:

+  Switch between Active Speaker and Continuous
Presence views.

+ IfinaHigh Definition meeting, switch between High Definition
(HD) and Standard Definition (SD) video.

« Pause or play the remote endpoint video.

4 If using the single video display, click the Picture-in-Picture
icon to create the video display shown in Figure 3-5.

You see yourself in the smaller Picture-in-Picture frame, and
you see the other meeting participants in larger remote frames.

5 If using the double video display, click the Swap Views icon to
swap the views displayed in the two video frames as shown in
Figure 3-6.

You see yourself in one frame, and you see the other meeting
participants in the other frame.

You can decide whether or not to grant to permission to muted attendees that use
the Raise Hand option.

Procedure

1 From the Actions menu, select Grant Request.
2 Select the attendee requesting permission to speak.

Moderating a Meeting 21



Viewing the SCOPIA Connector Help

VIEWING THE Moderators and attendees can access the SCOPIA Connector Help.
SCOPIA
CONNECTOR HELP

& Procedure

1 From the Help menu of the Sametime client, select Help
Topics.
The Sametime Help displays.

2 Select SCOPIA Connector for IBM Lotus Sametime in the
left panel.

VIEWING LICENSING
AND VERSION
INFORMATION

& Procedure

1 Click the question mark icon next to the Actions menu.
The About dialog box displays.
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PARTICIPATING IN A MEETING

= Muting Your Microphone or Speakers on page 24

m  Leaving a Meeting on page 25

m  Activating/Deactivating Video Channels on page 25

m  Changing the Video Layout on page 25

= Requesting Permission to Speak on page 25

= Viewing Meeting Information on page 26

= Viewing the SCOPIA Connector Help on page 26

m  Viewing Licensing and Version Information on page 26
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Muting Your Microphone or Speakers

MUTING YOUR You can mute your microphones and speakers only if a Moderator has not muted
MICROPHONE OR you.
SPEAKERS

Figure 4-1 Attendee Muted by Moderator

= (B S
el [Tyl [Ty

If you click the muted icon, this message displays: “You have been muted by the
Moderator of the meeting.” If you are muted by the moderator and want to speak,
use the Raise Hand option to request to speak. The moderator can grant or reject

your request to speak. For more information, see Requesting Permission to Speak
on page 25.

Procedure

1 On the toolbar, click the Mute/Unmute Microphone icon to mute or
unmute your microphone.

2 On the toolbar, click the Mute/Unmute Speakers icon to mute or
unmute your speakers.

Figure 4-2 Mute/Unmute Microphone and Mute/Unmute
Speakers

A< i
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LEAVING A
MEETING

ACTIVATING/
DEACTIVATING
VIDEO CHANNELS

CHANGING THE
VIDEO LAYOUT

REQUESTING
PERMISSION TO
SPEAK

Leaving a Meeting

See procedure in Leaving a Meeting on page 16.

See procedure in Activating/Deactivating Video Channels on page 17.

See procedure in Changing the Video Layout on page 19.

If you have been muted by the moderator, you can request permission to speak.

Procedure

1 From the Actions menu, select Raise Hand.
The Moderator can then decide whether or not to grant permission.

Participating in a Meeting 25



Viewing Meeting Information

VIEWING MEETING You can view instructions for connecting to your meeting that you may want to
INFORMATION send to other invitees.

& Procedure

1  Click the Display video meeting information icon in the upper toolbar,
as shown in Figure 4-3.

Figure 4-3 Display Meeting Information Icon
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File Edit Wew Tools Help
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2 The Meeting Information screen displays.

VIEWING THE See procedure in Viewing the SCOPIA Connector Help on page 22.
SCOPIA
CONNECTOR HELP

VIEWING LICENSING See procedure in Viewing Licensing and Version Information on page 22.
AND VERSION
INFORMATION
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INSTALLING AND CONFIGURING
SCOPIA CONNECTOR CONFERENCE
CLIENT CONTROL PANEL

What is the SCOPIA Connector Conference Client?

Installing the SCOPIA Connector Conference Client

Methods for Accessing the SCOPIA Connector Conference Client
Viewing System Settings

About Endpoint Bandwidth Information

How to Specify Conference Client Preferences

Installing and Configuring SCOPIA Connector Conference Client Control Panel 27



What is the SCOPIA Connector Conference Client?

WHAT IS THE
SCOPIA
CONNECTOR
CONFERENCE
CLIENT?

INSTALLING THE
SCOPIA
CONNECTOR
CONFERENCE
CLIENT

The SCOPIA Connector Conference Client automatically enables your desktop
with rich-media communication tools for audio and video meetings.

The SCOPIA Connector Conference Client enables you to

m  View the IP address of your computer, system hardware and software
information, and all the modules used by the SCOPIA Connector
Conference Client (via the Information section—see Viewing System
Settings on page 29).

= View the sent and received bandwidth for your local and remote
endpoints (via the Current call section—see About Endpoint Bandwidth
Information on page 30).

m  Specify your general, audio, video, and network preferences for the
Conference Client (via the Settings section—see How to Specify
Conference Client Preferences on page 33).

You must install the SCOPIA Connector Conference Client to participate in
meetings. Within minutes, you have complete access to rich-media web
meetings. You can start using SCOPIA Connector with or without a video
camera.

Procedure

1 If the Conference Client is not installed, or if your version needs to be
updated, SCOPIA Connector automatically prompts you to do so.

Follow the installation instructions.

Obtain and install a digital or analog video camera with a video capture
card to send video.

4 Make sure your computer is equipped with a sound card and
microphone to send audio, and a sound card with speakers or a headset
to receive audio.
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Methods for Accessing the SCOPIA Connector Conference Client

You can access the SCOPIA Connector Conference Client in these ways:

By selecting the Preferences or Statistics options from the Actions
menu.

If you select Preferences, the SCOPIA Connector Conference Client
Control Panel displays with the Settings section selected.

If you select Statistics, the SCOPIA Connector Conference Client
Control Panel displays with the Current call section selected.

By clicking the Network icon (Figure 5-1) in the bottom right corner of
the SCOPIA Connector user interface

The SCOPIA Connector Conference Client Control Panel displays with
the Current call section selected.

Figure 5-1 Network Icon

3
m By clicking the Conference Client Control Panel icon (Figure 5-2) in
the system tray and selecting the required section.
Figure 5-2 Conference Client Control Panel Icon
Conference Client - Ina Call
Procedure
1 On the sidebar of the Conference Client Control Panel, click

Information.

The System Information area displays information about your computer,
system hardware and software.

The Modules pane displays all the modules (services, codecs, filters, and
other small applications) and the versions used by the SCOPIA
Connector Conference Client.
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ABOUT ENDPOINT
BANDWIDTH
INFORMATION

LoCAL ENDPOINT
INFORMATION

Figure 5-3 Conference Client Control Panel: Information
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You can view the sent and received bandwidth for your local endpoint via the
Local tab in the Current call section of the SCOPIA Connector Conference Client
Control Panel.
You can view the sent and received bandwidth for your remote endpoint via the
Remote tab in the Current call section of the SCOPIA Connector Conference
Client Control Panel.

m  Local Endpoint Information on page 30

= Remote Endpoint Information on page 31

The Local tab of the Current call section displays your call status and the
bandwidth being sent and received by the Conference Client.
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About Endpoint Bandwidth Information

Figure 5-4 Conference Client Control Panel: Current Call—Local
Tab
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Table 5-1 Local Call Status and Bandwidth
Bandwidth Used Shows how much bandwidth is used (in Kbps). The

bandwidth available to you depends on your meeting

configuration settings, video and audio capture devices,

network, and other factors.

How my bandwidth is used Displays how much video, audio, data and control are
being used.

The Remote tab of the Current call section displays the status of other call
participants and the bandwidth that is being sent to and received from their
endpoints. It also lists the name of the user and the details of the call.
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Figure 5-5 Conference Client Control Panel: Current
Call—Remote Tab
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Table 5-2 Remote Call Status and Bandwidth
Name The name of the remote participant. Note: Your endpoint
displays in the list.
Kb/s The data that you receive from the remote participant.
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How to Specify Conference Client Preferences

Table 5-2 Remote Call Status and Bandwidth (continued)

Maximum send and receive The maximum send and receive rates of the remote
rates participants. Low values can explain low-quality audio or
video from a participant.

Loss sent and received The number of received packets that are lost from the
remote participant. With a bad connection or saturated
bandwidth, the packet loss increases and explains
low-quality audio or video from a participant.

Frames per second (Frm/s)  The number of frames per second being received from the
remote participant. It also indicates the number of frames
that you send from your endpoint.

You can specify your general, audio, video, and network preferences for the
Conference Client via the Settings section of the SCOPIA Connector Conference
Client Control Panel.

Note You cannot make changes while participating in a meeting.

The General tab of the Conference Client Control Panel enables you to perform
these actions:

m  Defining Your Server URL on page 35

m  Selecting a Language on page 35
The Audio tab of the Conference Client Control Panel enables you to perform
these actions:

m  Selecting a Recording Device on page 35

m  Selecting an Audio Input Source on page 36

m  Setting Your Sent Volume Level on page 36

m  Selecting a Playback Device on page 37

m  Selecting the Playback Volume on Your System on page 37

= Amplifying Your Microphone Input on page 37

m  Performing an Audio Test to Check Audio Quality on page 38
The Video tab of the Conference Client Control Panel enables you to perform
these actions:

m  Selecting a Camera on page 38
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DEFINING YOUR
SERVER URL

= Viewing or Modifying Camera Settings on page 38

m  Controlling Sent Video Speed and Quality on page 39

= Viewing Your Video Settings on page 39
The Network tab of the Conference Client Control Panel enables you to perform
these actions:

m  Controlling Network Bandwidth on page 40

m Indicating Proxy Server Settings on page 41
The Advanced tab of the Conference Client Control Panel enables you to perform
these actions:

m  Launching the Conference Client Control Panel When Your Computer
Starts on page 41

m  Launching the Conference Client Control Panel When Your Computer
Starts on page 41

m  Exiting the Conference Client Control Panel When the Meeting Ends on
page 42

m  Enabling Automatic Gain Control on page 42

= Removing Echo on page 42

m  Increasing Video Compression on page 43

m  Capturing Video on page 43

m  Selecting Your Preferred Image Size on page 44

m  Connecting Only to a Trusted Server on page 44

m  Sending RTP Media Packets via TCP on page 45

Note The default settings in the Advanced tab are factory tuned to be suitable in
most cases for audio and video calls. We recommend that you do not modify these
default settings.

You can define your home page for your meetings by setting a default URL for
your SCOPIA Connector server.

Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.
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How to Specify Conference Client Preferences

In the Conferencing Home pane, type your SCOPIA Connector server
URL in the Server URL field, or select one of these options:

o Use Current to use your current server as your conferencing home
page.

0 Use Default to use the default URL as your conferencing home
page.

o Use Blank to open the Conference Client Control Panel.

Click Save.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

In the Language pane, select the required language from the list and
then click Save.

Procedure

Before you create a call, double-click Conference Client in the
Windows Control Panel.

The SCOPIA Connector Conference Client Control Panel displays.
Click Settings.
Select the Audio tab.

In the Record pane, select the required recording device from the list in
the Device field and then click Save.
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@

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.

In the Record pane, select the required audio input source from the list
in the Line field.

Click Save.

For example, selecting CD Player instead of Microphone transmits
music during a meeting.

You can control the volume level that you transmit to other participants.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.

In the Record pane, use the slider to set the required volume level in the
Volume field and then click Save.

For example, selecting CD Player instead of Microphone transmits
music during a meeting.
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How to Specify Conference Client Preferences

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.

In the Playback pane, select the required playback device from the listin
the Device field and then click Save.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.

In the Playback pane, use the slider to set the required volume level in
the Volume field and then click Save.

You can amplify the input on your microphone by 20 decibels by using the
Microphone Boost option.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.
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3 Inthe Record pane, check the Microphone Boost option and then click
Save.

PERFORMING AN
AUDIO TEST TO
CHECK AUDIO
QUALITY

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Audio tab.
In the Playback pane, click Start audio test.
Click Stop audio test to end the test.

SELECTING A
CAMERA

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Video tab.

In the Capture pane, select the required recording device from the list in
the Device field and then click Save.

VIEWING OR You can view and modify your camera properties such as image controls and
MODIFYING CAMERA modes via the Source button.
SETTINGS

38 SCOPIA Connector for IBM Lotus Sametime User Guide



&

CONTROLLING SENT
VIDEO SPEED AND
QUALITY

&

VIEWING YOUR VIDEO
SETTINGS

&

How to Specify Conference Client Preferences

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Video tab.
In the Capture pane, click Source.
The Properties dialog box displays.

Modify camera settings as required and then click Close to return to the
Video tab.

In the Video tab, click Save.

You can control the ratio of speed and quality of the video you send by using the
I prefer to send option.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Video tab.

In the Capture pane, use the slider to set the required video quality in the
| prefer to send field and then click Save.

Procedure

From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Video tab.
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3 Inthe Capture pane, click Preview.
The Local Video Preview Window displays your configured video
quality.

4  Click Stop Preview to end the preview and to close the Local Video
Preview Window.

CONTROLLING
NETWORK
BANDWIDTH

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Network tab.
In the Bandwidth pane, select a bandwidth option:
a From the list, select Automatic.

The Automatic option enables the Conference Client to set its own
bandwidth.

-or-
b Select one of these options and enter values for send and receive

rates:

« Modem 56K

« ISDN 64K

+ ISDN 128K

+ Cable/DSL Low

+ Cable/DSL High

40 SCOPIA Connector for IBM Lotus Sametime User Guide



How to Specify Conference Client Preferences

« T1
% LAN
4 Click Save.

Note Your choice automatically sets your maximum send and receive rates.

INDICATING PROXY The Conference Client uses the proxy server settings of Internet Explorer when
SERVER SETTINGS the proxy type is set to “Automatic”. This setting typically does not need to be
changed. However, you can change the proxy type and disable the use of a proxy

server, or specify settings manually.
& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Network tab.

In the Proxy pane, select an option from the Proxy type list and type the
required proxy server information in the remaining fields.

4 Click Save.

LAUNCHING THE
CONFERENCE CLIENT
CONTROL PANEL
WHEN YOUR
COMPUTER STARTS

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

2  Select the Advanced tab.
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EXITING THE
CONFERENCE CLIENT
CONTROL PANEL
WHEN THE MEETING
ENDS

&
ENABLING
AUTOMATIC GAIN
CONTROL

=

REMOVING ECHO

3 Under General, check the Launch Conference Client Control Panel
when Windows starts option and then click Save.

Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.

Under General, check the Exit Conference Client Control Panel when
conference ends option and then click Save.

Automatic gain control automatically adjusts the power of the gain (audio
signal).

Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.

Under Audio, check the Automatic Gain Control option and then click
Save.

The Echo Cancellation option removes the echo (sound reverberation) often
heard in audio delivery.
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Typically, echo originates from the microphone transmitting the same sound that
your speakers are playing. Increasing the distance between your speakers and
microphone can also reduce echo.

We strongly recommend that you perform this procedure on your SCOPIA
Connector client.

Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.
Under Audio, check the Echo Cancellation option and then click Save.

You can increase the video compression rate for improved performance over the
network, but using this option might result in a blurred video image.

Note Do not use this option if your video capture device is of very high quality.

Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.

Under Video, check the Video Capture Noise Reduction Filter option
and then click Save.

You can control the video capture behavior of the SCOPIA Connector
Conference Client by using the Force High Capture Frame Rate option.

When unchecked, the SCOPIA Connector Conference Client does not capture
video at 30 fps under certain circumstances (for example, when insufficient CPU
resources are available).
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When checked, the SCOPIA Connector Conference Client overrides the 30 fps
video capture limit.

Note Because the SCOPIA Connector Conference Client does not include
Centrino processors when calculating CPU resources, clicking this option ensures
video capture is enabled when Centrino processors are present in laptops and so
on.

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.

Under Video, check the Force High Capture Frame Rate option and
then click Save.

SELECTING You can select the size of the video image that you want to send by using the
PREFERRED IMAGE Preferred image size option.
SIzE

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.

Under Video, select your preferred video size from the list in the
Preferred Video Size field and click Preview in the Video tab to see the
effects of this setting.

We recommend that you select the High Definition option.

CONNECTING ONLY You can instruct the SCOPIA Connector Conference Client to connect only to a
TO A TRUSTED SCOPIA Desktop server with a trusted certificate installed. This setting is
SERVER unchecked by default.
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& Procedure

1 From the Actions menu, select Preferences.
The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.
Select the Advanced tab.
Under Network, check the Connect Only To Trusted Server option.

Note Because the SCOPIA Desktop server ships with a self-signed
certificate which is not trusted, checking this option with a default installation
causes the SCOPIA Connector Conference Client to fail to connect to the
server. Administrators can replace the default self-sign certificate as required.

SENDING RTP MEDIA You can instruct the SCOPIA Connector Conference Client to send RTP media
PACKETS VIA TCP packets via TCP, rather than via UDP.

& Procedure

1 From the Actions menu, select Preferences.

The SCOPIA Connector Conference Client Control Panel displays with
the General tab of the Settings section selected.

Select the Advanced tab.
Under Network, check the Use TCP To Transport Media option.
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4  Select one of these options:

o Automatic—SCOPIA Desktop tries to send media over UDP, and
then switches to TCP if the UDP ports are not open.

o Always On—On connecting, SCOPIA Desktop sends media via
TCP.

o Always Off—SCOPIA Desktop always attempts to send media via
UDP.

Note To enable SCOPIA Desktop to work with encryption, a TCP
connection is required.
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